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   ดหมายขาวสํานักคอมพิวเตอร 
 

ปที่ 8 ฉบับที่ 4 กรกฎาคม - สิงหาคม 2547 

บันทึกจาก 
ผูอํานวยการสํานักคอมพิวเตอร 

ในเดือนสิงหาคมนี้ มหาวิทยาลัยไดรับเรื่องจากกระทรวง
เทคโนโลยีสารสนเทศและการสื่อสาร และสํานักบริการ
เทคโนโลยีสารสนเทศภาครัฐ (สบทร.) ใหประสานการดําเนิน
งาน 2 เรื่อง คือเรื่องที่หนึ่ง ขอความอนุเคราะหรวบรวมขอมูล
ผูบริหารระดับ 8 หรือเทียบเทาขึ้นไป เพื่อจัดทําใบรับรอง
อิเล็กทรอนิกส เรื่องที่สอง ขอเชิญผูประสานงานเขารวมอบรม
การติดตั้งและใชงานใบรับรองอิเล็กทรอนิกส ตามโครงการ 
ใบรับรองอิเล็กทรอนิกสเพื่อขาราชการ ซึ่งจะอบรมในวันที่  
20-21 กันยายน 2547   สํานักคอมพิวเตอรก็จะสงเจาหนาที่
ไปอบรมดวย 
จากหนังสือทั้ง 2 ฉบับ ทําใหทราบวากระทรวงเทคโนโลยี

สารสนเทศและการสื่อสาร กําลังเรงดําเนินการโครงการ 
ใบรับรองอิเล็กทรอนิกสเพื่อขาราชการ เพื่อใหบรรลุตามแผน
ของกระทรวงฯที่จะพัฒนาระบบลายมือชื่อดิจิทัล(Digital 
Signature) แจกจายใหหนวยงานตาง ๆ ภายใน 30 กันยายน 
2547 มีเปาหมายใหได 20,000 ใบรับรองอิเล็กทรอนิกส โดยมี 
สบทร. เปนผูดําเนินการทางเทคนิค  
ใบรับรองอิเล็กทรอนิกสคือการจดทะเบียนผูที่ใชระบบการ

ส่ือสารอิเล็กทรอนิกสอยางเปนทางการเพื่อใหสามารถดําเนิน
ธุรกรรมทางอิเล็กทรอนิกสไดอยางปลอดภัยและถูกตองตาม
ระเบียบราชการ เชน การสงหนังสือราชการผานเครือขาย 
อินเทอรเน็ต  โดยผูที่จดทะเบียนขอใบรับรองอิเล็กทรอนิกสจะ
ไดรหัส 2 รหัส คือกุญแจสาธารณะ (Public key)  เพื่อแจงให
ผูที่ตองการสื่อสารทราบ และจะไดกุญแจสวนตัว (Private 
key) เพื่อดําเนินการรับสงขอมูล 
สํานักคอมพิวเตอรจึงขอใหขอมูลแกผูอยูในขายที่จะได 

ใบรับรองอิเล็กทรอนิกส  เพื่อทราบความเปนมา และใน 
ฉบับหนาเราจะนําส่ิงที่ไดจากการอบรมมาเลาสูกันฟงตอไป  

 
กิจกรรมและบริการ 

 
 เครือขาย Wi-IS 
      

 
ระบบสารสนเทศผานเว็บ

บริการ   

 
 ปฏิทิน มศว  
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2 จดหมายขาวสํานักคอมพิวเตอร 

 

เลาสูกันฟงงานเครือขายบัวศร ี

  มหัทธวัฒน รักษาเกียรติศักดิ์ & นคร บริพนธมงคล 
 
ในชวงที่ผานมาเครือขายบัวศรี ไดมีการปรับปรุงเพิ่มเติม

เพื่อเพิ่มประสิทธิภาพการใชงานมากขึ้น  สงผลให คณาจารย 
นิสิต และบุคลากร สามารถใชงานเครือขายบัวศรีไดประโยชน
คุมคา ดังนั้นในวันนี้จะไดเลาสูกันฟงถึงส่ิงตางๆ ที่  สํานัก
คอมพิวเตอร ไดดําเนินการไปแลว ไดแก บริการเครือขาย 
ไรสาย ( Wireless Lan)  การเพิ่มชองทางออกสูอินเทอรเน็ต 
ชองทางที่ 2   และ การแจงปญหาเครือขายผานเว็บ   ส่ิงตาง ๆ 
เหลานี้จะมีประโยชนตอผูใช  ทําใหการใชงานทําไดสะดวกยิ่ง
ขึ้นและยังเพิ่มประสิทธิภาพในการใชงานระบบเครือขายบัวศรี 
และอินเทอรเน็ตโดยรวมดวย 
เครือขาย Wi-IS (Wireless Internet Service) 
ปจจุบันเครือขายไรสาย เปนเครือขายที่กําลังไดรับความ

นิยมเปนอยางมาก  ประกอบกับอุปกรณเครือขายไรสายเริ่มมี
ราคาถูกและซื้อหาใชงานไดงายขึ้น  ในปงบประมาณ 2547 
สํานักคอมพิวเตอรไดเริ่มโครงการนํารองเครือขายไรสาย และ
ไดติดตั้งแลว จํานวน 3 จุด ไดแก สํานักคอมพิวเตอร บริเวณ
ห อ งปฏิ บั ติ ก ารคอมพิ ว เต อ ร  ชั้ น  3 อาคาร  16, สํ านั ก 
หอสมุดกลาง ประสานมิตร ชั้น 3 ซึ่งครอบคลุมบริเวณใชงาน 
ชั้น 2 และ ชั้น 4 บางสวน,  และหอสมุด มศว องครักษ  ชั้น 1 
โดยมาตรฐานของอุปกรณที่ติดตั้งในครั้งนี้ เปนมาตรฐาน 
IEEE802.1g สามารถรองรับการใชงานที่ความเร็ว 54 Mbps 
แตถ าท านใดมีอุปกรณ ที่ เป น  มาตรฐาน  IEEE802.1b ก็
สามารถใชงานได สวนการขยายเครือขายไรสายระยะที่ 2 นั้น
คงจะไมนานเกินรอ  ซึ่งจะไดมีการขยายเครือขาย Wireless 
Lan ใหครอบคลุมทั่วมหาวทิยาลัย  

 

เว็บเพจเครือขาย Wi-IS (Wireless Internet Service) 
http://wireless.swu.ac.th  

 

การใชงานอินเทอรเน็ตชองทางที่ 2 
สํานักคอมพิวเตอรทราบถึงปญหาการใชงานอินเทอรเน็ต 

ของประชาคม ชาว มศว อันเนื่องมาจากการขัดของของเครือขาย 
UniNet    จึงได เพิ่มชองทางออกสูอินเทอรเน็ต ชองทางที่  2  
ขนาด 2 Mbps      ตั้งแตวันที่ 16 มิถุนายน 2547  นอกเหนือจาก
การออกอินเทอรเน็ตผานเครือขาย Uninet    เพื่อใหเครือขาย 
บัวศรีสามารถติดตอกับอินเทอรเน็ตไดตลอดเวลา  ในกรณีที่ link 
ของเครือขาย Uninet  ที่เปนเสนทางหลักเกิดปญหา  
 

 
 

แสดงการใชงานอินเทอรเน็ต ชองทางที่ 2 

การแจงปญหาผานระบบเครือขาย 
จากปญหาที่เกิดขึ้นภายในระบบเครือขายบัวศรี  บางครั้งผูใช

จะไมทราบสาเหตุของปญหาตาง ๆ   ดังนั้นสํานักคอมพิวเตอร 
จึงไดพัฒนาระบบแจงขาวปญหาเครือขาย เพื่อใหสะดวกรวดเร็ว
ในการรับทราบขาวสารเกี่ยวกับเครือขายบัวศรี ไมวาจะเปน
ปญหาในเรื่องของการใชงาน  หรือปญหาระบบเครือขายขัดของ   
สามารถเขาดูไดที่ http://www.swu.ac.th แลว click ที่ขาวเครือขาย
บัวศรี ที่อยูดานลางซึ่งจะเห็นรายละเอียดทั้งหมดของขาวเกี่ยว
กับเครือขายบัวศรี 

 

การพัฒนาระบบเครือขายบัวศรีจะยังไมหยุดเพียงเทานี้ ใน
โอกาสหนาคงไดพบกับงานในกาวตอไปของพวกเรา  ที่จะให
บริการแกผูใชใหสามารถใชงานเครือขายบัวศรีและอินเทอรเน็ต
ไดสะดวกและรวดเร็วยิ่งขึ้น  
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บริการระบบสารสนเทศนิสิตผานเว็บ 

  ไพโรจน ผาสุวรรณ & พรทิพย พงษสวัสดิ์ 
 
จากฉบับที่ แล ว    เราได แนะนํ าทุกท านให ได รูจั กกับ  

ระบบสารสนเทศมหาวิทยาลัย SUPREME2004   ในสวน
ของ ระบบลงทะเบียนนิสิต  ซึ่งก็คิดวาหลาย ๆ ทานคงไดเขาไป
สัมผัสและใชบริการกันบางแลว   ในฉบับนี้   เรามีบริการใหมที่
จะขอแนะนําให  คณาจารย  และนิ สิต   ทุกทาน  ได เขาไป 
ใชบริการเพื่อการสอบถามขอมูล ในเรื่องตาง ๆ  ผานเว็บ   
นั่นก็คือ  ระบบสารสนเทศนิสิต  ซึ่งคณาจารย และนิสิต 
ทุกทานสามารถใชบริการโดยการใช Buasri ID ของตนเอง  ซึ่ง
จะสามารถใชบริการไดตามสิทธิและภาระหนาที่ของแตละ
บุคคลดังนี้ 

 
เว็บบริการระบบสารสนเทศนิสิต   
http://supreme.swu.ac.th 

นิสิต 
บริการ สอบถาม/ตรวจสอบ ขอมูลตางๆ ไดแก 

• ประวัตินิสิต  แสดงชื่อ นามสกุล ที่อยู ชื่ออาจารยที่ปรึกษา 
• ตารางเรียนภาคการศึกษาปจจุบัน  แสดงหองเรียน   

วัน-เวลา  อาจารยผูสอน  
• ตารางสอบ  เพื่อเปนการเตรียมตัวลวงหนาวาสอบเมื่อใด 
• ผลการลงทะเบียนเรียน แสดงรายวิชา ตอนที่ที่ลงทะเบียน  

ผลการลงทะเบียนและผลการชําระเงินคาธรรมเนียม 
การศึกษา 

• ผลการเรียนในภาคการศึกษาที่ผานมา ตั้งแตเขาศึกษา
จนถึงภาคเรียนปจจุบัน    

• หลักสูตรการศึกษาของตนเอง  เพื่อดูวาเรียนมาแลว
เทาใด  เหลืออีกกี่รายวิชาจึงจะจบหลักสูตร 

• หลักสูตรกิจกรรม แสดงรายการกิจกรรมที่เขารวม   
รวมทั้งตรวจสอบการผานหลักสูตรกิจกรรม 

 

อาจารย 
บริการขอมูลในการบริหารและจัดการเรียน – การสอน  

• ตรวจสอบความถูกตองของขอมูลตนเอง (profile) 
• ขอมูลนิสิตที่ลงทะเบียนเรียนในรายวิชาที่ทานสอน  

(ตารางสอน)  
• สามารถติดตอนิสิตผานทาง E-mail เปนรายบุคคล หรือ

ทั้งกลุม เชน การนัดสงงาน  การแจงผลการสอบ  การยาย
หองเรียน  ฯลฯ 

• สามารถสอบถามขอมูลตารางสอน - ตารางสอบ  พรอม
พิมพรายงานเชน ทบ.30 (ตารางสอน) ตารางหองเรียน  
ตารางหองสอบ 

• ภาระงานสอน  แสดงรายวิชาที่สอนและคา SCH 
• ผลการเรียนของนิสิตในรายวิชาที่สอน 

 
อาจารยที่ปรึกษา 
บริการสอบถามขอมูลของนิสิตที่ดูแล เพื่อชวยใหการดูแลและ

ติดตามนิสิต สะดวก รวดเร็ว มากยิ่งขึ้น   
• แสดงรายชื่อนิสิตที่ดูแล  แจงเตือนกรณีผลการเรียนมี

ปญหาเชน เกรดเฉลี่ยต่ํากวา 2.00 (เตรียม Pro)  
• แสดงสถานการณลงทะเบียนเรียนในภาคเรียนปจจุบัน 
• สอบถามขอมูลเพิ่มเติมของนิสิต เชน ตารางเรียน-ตาราง

สอบ  ผลการเรียน  ผลการเขารวมกิจกรรม ผลการผาน 
กิจกรรม  เพื่อดูแนวโนมการสาํเร็จการศึกษา 

• การสงผลการผานกิจกรรมของนิสิต ที่จะสําเร็จการศึกษา 
ขอเชิญชวนนิสิต  อาจารยผูสอน และอาจารยที่ปรึกษา  

สัมผัสและใชบริการ ระบบสารสนเทศนิสิต 
ผานอินเทอรเน็ต  ไดที่  http://supreme.swu.ac.th 
และขอรับ Buasri ID ไดที่ สํานักคอมพิวเตอร 
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ไวรัสวายรายบนอินเทอรเน็ต 
�  วิโรจน เตี๋ยอนุกูล �

 
ไวรัสเปนภัยของคอมพิวเตอรที่ รูจักกันมาตั้ งแตสมัยที่ 

อินเทอรเน็ตยังไมไดเปนที่นิยมกัน มันถูกกลาวถึงมาโดยตลอด
เลย ตัวอยางงายๆ ที่พบบอยๆ ก็อยางเชน Macro Virus ที่ติดใน
โปรแกรม word ที่คุณใชพิมพงานทั่วไป มันจะทําใหเอกสารของ
คุณรวนไป และใชโปรแกรมเปดอานหรือแกไขตอไมได เปนตน 
ยิ่งเมื่ออินเทอรเน็ตไดเขามาสูชีวิตประจําวันของเรามากขึ้นมี 
การใชงานกันอยางแพรหลายก็ยิ่ง  ทําใหมีการสงขอมูลถึงกันได
สะดวกรวดเร็วขึ้ น  ผลที่ ตามมาก็คือ  ทํ าให เจ าไวรัสตั วดี  
(นาจะเรียกวา”ไวรัสตัวราย”จะเหมาะสมกวา) สามารถแพร
กระจายไดอยางรวดเร็วขึ้นตามไปดวย ป จ จุ บั น จึ ง มี ไ ว รั ส 
รูปแบบตาง ๆ แปลก ๆ ใหม  ๆ มากมายออกมาอาละวาด 
หลอกหลอนใหเราตกใจกลัวไปตาม ๆ กัน 
ปญหาเกี่ยวกับไวรัสและแนวทางการบริหารจัดการ  
ไวรัสที่ โดงดังมาก ๆ ในชวงเดือน สิงหาคม พ.ศ. 2547 ที่ 

ผานมาคือไวรัสชื่อ W32.Sasser.Worm   ซึ่งเปนหนอน ที่ออก
อาละวาดไปทั่วมหาวิทยาลัย สรางความเสียหายใหแกระบบ 
ทําใหเครือขายบัวศรีทํางานชาลงอยางมาก  จนทําใหระบบ
สําคัญของมหาวิทยาลัย เชน ระบบสารสนเทศของมหาวิทยาลัย
ใชงานไมได   
สํานักคอมพิวเตอรจึงไดดําเนินการแกไขกันอยางเรงดวน 

จนกลับคืนสูสภาวะปกติได  โดยเฉพาะระบบปฏิบัติการที่ไดรับ
ผลกระทบก็คือ Windows 2000 และ Windows XPสาเหตุของ
การระบาดมาจากเครื่องคอมพิวเตอร ที่ไมไดติดตั้งโปรแกรม 
Antivirus และการอัพเดท Windows ใหทันสมัย 
หนอน หรือ Worm คืออะไร 

 หนอนเปนโปรแกรมที่ถูกออกแบบมาใหมีความสามารถใน
การทํ าสําเนาตัวเองด วยโคดที่ อยู ในตัวมันเองโดยอิสระ    
ไมตองรอการเรียกใชงานจากผูใช  ซึ่งแตกตางจากไวรัส    แต
ลักษณะโดยทั่วไปจะคลายกับไวรัสนั่นเอง    หนอนสามารถ 
แพรกระจายตัวเองจากเครื่องคอมพิวเตอรเครื่องหนึ่งไปยังอีก
เครื่องหนึ่ง   โดยอาศัยระบบเครือขายแพรกระจายไดอยาง 
รวดเร็วและทําความเสียหายรุนแรงกวาไวรัสมาก    
จากรายงานสถิติพบวาหนอนสามารถแพรกระจายไปบน

ระบบเครือขายที่มีคอมพิวเตอรมากกวา 5,000 เครื่องภายใน
ระยะเวลาเพียงไมกี่ชั่วโมงเทานั้น (มันสามารถทําความเสียหาย
ตอระบบไดจากภายใน ก็เหมือนกับหนอนที่กัดกินผลไมจาก 
ภายใน) หนอนมักจะติดกับโปรแกรมที่เรานิยมใชกันทั่วไป   เชน 
โปรแกรมสําหรับ รับ-สง อีเมล (MS Outlook 97/98/2000 หรือ 
Outlook Express) เพื่อสงตัวเองไปยังผูรับอีเมลคนอื่นๆ ที่มีชื่อ

อยูในรายการ Address Book โดยหนอนจะแนบตัวเองไปกับ
อีเมลที่ถูกสงออกไปและอาศัยชองโหวในซอฟตแวร เชน ชองโหว
ของ Outlook Express เปนตน   หรือมักจะแพรกระจายผาน
โปรแกรมสนทนา IRC (Internet Relay Chat) อยูบอยๆ 
บริการติดตั้งระบบปองกันไวรัส 
สํานักคอมพิวเตอรไดดําเนินการจัดทําระบบปองกันไวรัส 

เพื่ อใหบ ริการกับเครื่องคอมพิ วเตอรที่ เชื่อมตอกับระบบ 
เครือขายบัวศรี  
� การติดตั้งโปรแกรม AntiVirus 
เป นระบบป องกั น ไวรัสประกอบไปด วย  Trend Micro 

OfficeScan Corporate Edition (OfficeScan) จะทํ าหน าที่ ใน
การตรวจจับไวรัสและ Update Virus signature ใหอัตโนมัติ 
ทุกชั่วโมง ระบบปองกันไวรัสนี้สามารถใชงานไดกับระบบ 
ปฏิบัติการ Windows 98 และ Internet Explorer 5 เปนตนไป  
� การติดตั้ง Software Update Service (SUS Server) 
ทําหนาที่ในการติดตั้ง Security Patch (Hot fix) และ Service 

Pack ใหอัตโนมัติ  สามารถใชงานไดกับระบบปฏิบัติการ 
Windows 2000 SP3 เปนตนไป 

ทานสามารถใชบริการนี้ไดที่  http://www.swu.ac.th หัวขอ  
ขาวเครือขายบัวศรี > การติดตั้งระบบปองกันไวรัส  
เพื่อเปนการปองกันการระบาดไวรัสคอมพิวเตอร ดังนั้นเครื่อง

คอมพิวเตอรทุกเครื่องจําเปนตองติดตั้งโปรแกรม Antivirus และ 
Software Update Service 
สามขั้นตอนที่ชวยใหคุณแนใจวาคอมพิวเตอรของ
คุณไดรับการปองกันแลว 
ขั้นตอนที่ 1 ใชอินเทอรเน็ตไฟรวอลล Windows XP ขึ้นไป 
ขั้นตอนที่ 2 ติดตั้ง Software Update Services (SUS) เพื่อ

อัพเดท Windows ใหทันสมัยอยูเสมอ 
ขั้นตอนที่ 3 ติดตั้งซอฟตแวรปองกัน (Antivirus OfficeScan) 

สรุป 
"ไวรัสคอมพิวเตอรจะไมสามารถทําลายขอมูล และสรางความ

เสียหายตอระบบได หากผูใชคอมพิวเตอรทุกคนมีวินัยในการใช
งานระบบคอมพิวเตอร" � 
ขอมูลอางอิง 

http://www.microsoft.com/      
     http://thaicert.nectec.or.th/ 

http://www.trendmicro.com/  
     http://www.symantec.com/ 
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การจัดการเรียนการสอนออนไลนดวยระบบ Open Source LMS “ATutor”:  
กรณีศึกษาของมหาวิทยาลัยศรีนครินทรวิโรฒ 

 สุณี  รักษาเกียรติศักดิ์  
 
ในจดหมายข าวฉบั บส งท ายป งบประมาณ  2547 นี้  

ขอนําเสนอบทคัดยอผลงานวิจัย เรื่อง การจัดการเรียนการสอน
ออนไลนด วยระบบ  Open Source LMS ”ATutor” : กรณี
ศึกษาของมหาวิทยาลัยศรีนครินทรวิโรฒ  โดย ผศ.ดร.สุณี 
รักษาเกียรติศักดิ์, ดร.ขนิษฐา  รุจิโรจน, อ.วราภรณ วิยานนท, 
อ.สาโรช เมาลานนท  ที่นําเสนอในการประชุมวิชาการวิจัย
ส ถ าบั น  ป ระจํ าป  2547 วั น ที่  10 – 11 กั น ย ายน  2547  
ณ ศูนยประชุมสถาบันวิจัยจุฬาภรณ กรุงเทพมหานคร ดังนี้   
บทคัดยอ 
ในปจจุบันหนวยงานการศึกษาไดตื่นตัวกันเปนอยางมากใน

การใชเทคโนโลยีสารสนเทศและการสื่อสารหรือไอซีที (ICT) ใน
การจัดการเรียนการสอนแบออนไลน หรือ e-learning  ซึ่งเปน
ยุทธศาสตรหนึ่งของการพัฒนาองคกรสูสังคมฐานความรู ในการ
ดําเนินการดังกลาวจําเปนอยางยิ่งที่จะตองหาระบบในการจัด
การเรียนแบบออนไลน (Learning Management System หรือ 
LMS)  มาใช  ระบบเหลานี้มีทั้งที่เปนระบบเชิงพาณิชยที่ตองเสีย
คาบริการในการใชงานรายป  และระบบแบบ Open source  
ซึ่งไมมีคาใชจายดานซอฟตแวร และหนวยงานสามารถนํามา
ป รับ แต งให เข ากั บ สภ าพ แวดล อม ของหน วย งาน ได   
มหาวิทยาลัยศรีนครินทรวิโรฒไดทดลองปรับแตงใชระบบ Open 
source LMS ชื่อ  “ATutor” ของมหาวิทยาลัยโทรอนโท ประเทศ
แคนาดา (http://www.atutor.ca) ตั้งแตภาคการศึกษาที่  1/2546 
(มิถุนายน  2546) ใน  version 1.1 และพบวาเป นระบบที่ มี 
องคประกอบของระบบการจัดการเรียนการสอนออนไลนที่
ครบถวน ติดตั้งงาย ใชงานงาย และมีความเชื่อถือไดสูง  ระบบ
ได มีการพัฒนาอยางตอเนื่องและรวดเร็ว  โดยในปจจุบัน 
(สิงหาคม 2547)  ระบบ ATutor ไดเผยแพรใหสาธารณชนไดใช
ใน version 1.4.1 แลว  และมหาวิทยาลัยศรีนครินทรวิโรฒได
ปรับเปล่ียนระบบเปน version 1.4.1 ในภาคการศึกษาที่ 1/2547  
นอกจากนั้นแลวมหาวิทยาลัยศรีนครินทรวิโรฒยังไดดําเนินการ
วิจัยและพัฒนาปรับแตงการใชงานเพิ่มเติม เชน การเชื่อมตอ
ระบบ ATutor กับฐานขอมูลของมหาวิทยาลัย การพัฒนาระบบ
การวิเคราะหขอสอบใน ATutor เปนตน ตลอดจนการจัดทํา
เอกสารประกอบการใชงานและเอกสารประกอบการอบรม  และ
การเขียนบทความวิชาการเพื่อเปนแรงกระตุนอยางตอเนื่อง    
อีกทั้งยังไดดําเนินการถายทอดและแลกเปลี่ยนประสบการณ 

ในการใชงาน   เพื่อสรางเครือขายการใชงานรวมกันระหวาง 
หนวยงานการศึกษาในประเทศไทยใหเปนอีกทางเลือกหนึ่งของ
การใชระบบ LMS แบบ Open Source ที่ ไม มีคาใชจายดาน
ซอฟตแวร   ไดจัดโครงการสัมมนาปฏิบัติการขึ้นครั้งแรกในวันที่ 
24-25 มกราคม 2547 โดยจัด 2 หลักสูตรพรอมกัน คือ หลักสูตร 1: 
การใชระบบ ATutor สําหรับอาจารยผูใชระบบ และ หลักสูตร 2: 
การติดตั้งและดูแลระบบ ATutor สําหรับผูติดตั้งดูแลระบบ   รับ
หลักสูตรละ 30 คน  จัดรุนที่ 2 ในวันที่ 1–2 เมษายน 2547 และ
รุนที่ 3 ในวันที่ 10-11 กรกฎาคม 2547  โดยในรุนที่ 3 มีการเพิ่ม
หลักสูตร 3: การปรับแตงระบบ ATutor ดวย PHP และ MySQL  
สําหรับผูที่ผานหลักสูตร 1 หรือหลักสูตร 2 มาแลว และจัดตอ
เนื่องในวันที่ 12-14 กรกฎาคม 2547   ในการจัดในรุนที่ 2 และ 
รุนที่  3 มีผูสมัครเขารวมโครงการเกินกวาจํานวนที่จะรับได   
มีผูเขารวมโครงการทั้งส้ินในการจัดทั้ง 3 ครั้ง จํานวน  248 คน 
จากหนวยงานการศึกษาทั้งส้ิน 100 หนวยงานทั่วประเทศ  หลาย
หนวยงานไดมีการติดตั้งระบบ ATutor ในหนวยงานและมีการ 
อบรมบุคลากรในหนวยงานแลว  หลายหนวยงานอยูในระหวาง
การเตรียมการเนื่องดวยตองรองบประมาณในปถัดไป  คาดวาใน
ปงบประมาณ 2548 จะมีหนวยงานที่ผานการอบรมดําเนินการ
ติดตั้งและใชงานระบบ  ATutor กันมากขึ้น  แตอยางไรก็ดีการ
เติบโตที่ยั่งยืนตองอาศัยนโยบายและวิสัยทัศนของผูบริหาร
หนวยงานอยางมากที่จะเปนผูผลักดันใหการดําเนินงานบรรลุ
เปาหมาย 

 

ขอเชิญชวนคณาจารย/นิสิต มาใชงานระบบ ATutor ไดที่ 
http://course.swu.ac.th/browse.php 
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เทคนิคการนํารูปภาพประกอบจดหมายขาว 

�  สมบุญ อุดมพรยิ่ง & พีระ แพทยประเสริฐ �
 
ปจจุบันการจัดทําตนฉบับจดหมายขาว หรือวารสาร ทําได

งายกวาแตกอนมาก เนื่องจากมีการนําเทคโนโลยีคอมพิวเตอร
มาชวยในการทํางานมากขึ้น เชน ใชโปรแกรม Microsoft Word  
ในการจัดทําตนฉบับ 
จากประสบการณ ในการจั ดทํ าจดหมายข าวสํ านั ก

คอมพิวเตอรมาประมาณเกือบ 3 ป  การจัดทําตนฉบับจดหมาย
ขาว โดยใชโปรแกรม Microsoft Word   สวนใหญมักจะมีรูปภาพ
ประกอบบทความ   เพื่อทําใหผูอานไดเกิดความสนใจและเขาใจ
ในเนื้อหาบทความมากยิ่งขึ้น   การนํารูปภาพมาประกอบในบท
ความนั้น ไมยาก   สามารถใชคําส่ังคัดลอกและวาง หรือการนํา
รูปภาพมาแทรกในเนื้อหา   แตเคยมีใครสังเกตบางไหมวาทําไม
ขนาดของแฟมขอมูลถึงไดมีขนาดใหญขึ้นเมื่อเทียบกับแฟม 
ขอมูลที่มีแตเนื้อหาอยางเดียว  และจะมีเทคนิคอยางไรในการที่
จะชวยใหแฟมขอมูลดังกลาวมีขนาดเล็กลงได    
ทําไมแฟมขอมูลบทความที่มีรูปภาพประกอบจึงมี
ขนาดใหญ 
การนํารูปภาพมาประกอบเนื้อหาหรือบทความนั้น  สวนใหญ

มักจะใชวิธีการคัดลอกและวางรูปภาพตนฉบับ  หรือใชคําส่ัง
แทรก (Insert > Picture) รูปภาพตนฉบับลงในเนื้อหา   บางครั้ง
รูปภาพที่ไดมีขนาดไมตรงกับความตองการ ก็ทําการขยาย/ยอ
ขนาดดวยการคลิกที่รูปภาพ และลากมุมของรูปภาพขึ้นลง เพื่อ
ขยาย/ยอขนาดลง  ถึงแมวาการทําดวยวิธีการดังกลาวจะได 
รูปภาพขนาดที่ตองการก็จริง      แตในความเปนจริงแลวขนาด
ของแฟมขอมูลรูปภาพไมไดเพิ่มหรือลดตามไปดวย   ทําให 
แฟมขอมูลบทความจึงมีขนาดใหญ ตามแฟมขอมูลรูปภาพที่ใช
ประกอบบทความดังกลาว 

 
เทคนิคการลดขนาดแฟมขอมูลรูปภาพ 
สําหรับโปรแกรม Microsoft Word 9X, 2000 นั้น ยังไมมีฟงก

ชั่นในการชวยลดขนาดแฟมขอมูลรูปภาพ  จึงจําเปนตองใช
โปรแกรมตัวอื่น มาชวยในการลดขนาดขอมูลรูปภาพลง  เชน 
Photoshop แตสําหรับโปรแกรม Microsoft Word  XP 
ขึ้นไป จะมีฟงกชั่นในการบีบอัดรูปภาพใหมีขนาดเล็กลงได 
� โปรแกรม Photoshop  
เปดแฟมขอมูลรูปภาพผานโปรแกรม Photoshop และเลือก 

เมนู  Insert > Picture > Image Size… ดังรูป 

 
จะปรากฏจอภาพเพื่อกําหนดขนาดของรูปภาพตามตองการ 

ไดที่ Pixel Dimensions ซึ่งจะแสดงขนาดของแฟมขอมูลรูปภาพ
ใหเห็นมีหนวยนับเปน Kbyte  และกดปุม OK  

 
หลังจากนั้นใหทําการบันทึกแฟมขอมูลรูปภาพเปนชื่อแฟม 

ขอมูลรูปภาพใหม  เพื่อนําไปแทรกลงในบทความตอไป 
� โปรแกรม Microsoft Word  XP 
เปดแฟมขอมูลรูปภาพผานโปรแกรม Microsofrt Word XP 

คลิกที่รูปภาพ แลวเลือกเมนู Format > Picture > Picture > 
Compress..  จะปรากฏจอภาพ ดังรูป 

 
เลือก Options เปน Compress Picture  และกดปุม OK   

พรอมทั้งทําการ Save แฟมขอมูล  โปรแกรมจะทําการบีบอัดรูป
ภาพ ทําใหแฟมขอมูลที่จัดเก็บมีขนาดเล็กลง� 
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ปฏิทิน มศว : ระบบบริการใหมผานเว็บ 
�  สุวิมล คงศักดิ์ตระกูล �

 
ในเว็บไซตใหมของมหาวิทยาลัย ซึ่งไดมีการเปดตัวไปแลว

ตั้งแตวันที่ 28 มิถุนายน ที่ผานมานั้น นอกจากจะพบกับรูปแบบ
และการนําเสนอสาระเนื้อหาใหม ๆ ที่เปล่ียนไปจากเดิมแลว 
บนโฮมเพจใหมจะมีการเนนในเรื่องการประชาสัมพันธขาวและ
กิจกรรมตาง ๆ ของมหาวิทยาลัย เพื่อใหเปนส่ือกลางในการ
แจงขาวความเคลื่อนไหวตาง ๆ ที่เกิดขึ้นในมหาวิทยาลัย และ
เผยแพรสูประชาคมของ มศว และบุคคลทั่วไปที่ไดเขามาแวะชม
เว็บไซตของมหาวิทยาลัย ในสวนของกิจกรรมจะมีการนําเสนอใน
รูปแบบที่เรียกวา ปฏิทินกิจกรรม ซึ่งเปนการประกาศใหทราบ
วาในวันหนึ่ง ๆ  มีกิจกรรมอะไรเกิดขึ้นบาง เวลาใด และจัดขึ้น ณ 
สถานที่แหงใด ประกาศดังกลาวเปนสวนหนึ่งของขอมูลที่มีอยูใน
ระบบที่เรียกวา ปฏิทิน มศว ซึ่งเปนระบบบริการผานเว็บระบบ
ใหมที่ทีมงานเว็บของมหาวิทยาลัยไดพัฒนาขึ้น เพื่อใหเปนแหลง
รวมและนําเสนอกําหนดการจัดกิจกรรมทั่วไปที่หนวยงานใน
มหาวิทยาลัยจัดขึ้น นอกจากนั้นยังมีการนําเสนอขอมูลกําหนด
การปฏิทินการศึกษาทั้งในระดับปริญาตรีและบัณฑิตศึกษา
ตามประกาศของมหาวิทยาลัย 
ระบบปฏิทิน มศว 
ระบบปฏิทิน มศว (SWU Calendar) เปนบริการผานเว็บที่

สํานักคอมพิวเตอรไดพัฒนาขึ้นเพื่อเปนเครื่องมือใหบริการดาน
การประกาศแจงปฏิทินกิจกรรมและปฏิทินการศึกษาผานเว็บ ซึ่ง
จะชวยใหคณาจารย บุคลากร นิสิต รวมทั้งผูสนใจทั่วไป ไดรับ
ขาวและกําหนดการจัดกิจกรรมตาง ๆ ของมหาวิทยาลัยไดอยาง
สะดวกและรวดเร็ว นับเปนอีกชองทางหนึ่งของการสื่อสารและ
เผยแพรประชาสัมพันธของมหาวิทยาลัยเพื่อไปสูกลุมเปาหมาย
ทั้งภายในและนอกมหาวิทยาลัยโดยผานเครือขายอินเทอรเน็ต 
บริการนี้อยูที่ใด 
ผูสนใจสามารถเขาใชระบบงานปฏิทิน มศว ไดโดยไปที่ 

calendar.swu.ac.th   หรือ จากโฮมเพจของมหาวิทยาลัย
คลิกที่หัวขอ ปฏิทินกิจกรรม ซึ่งเปนลิงคที่พาไปยังปฏิทิน มศว 

�  ปฏิทินกิจกรรม 
ในหนาแรกจะแสดงรายการกําหนดการกิจกรรมลาสุด 6 รายการ 

โดยจะแสดงวันที่จัดกิจกรรม เวลา หัวขอ สถานที่จัดกิจกรรมและ
เบอรโทรศัพทเพื่อการติดตอสอบถามรายละเอียดเพิ่มเติม 
เพื่ออํานวยความสะดวกแกผูเขาชม ระบบไดจัดเตรียมกลุม

เมนูเพื่อแสดงปฏิทินกิจกรรมออกเปน ปฏิทินกิจกรรมประจําวันนี้ 
(Today), ปฏิทินกิจกรรมวันพรุงนี้ (Tomorrow), ปฏิทินกิจกรรม
สัปดาหนี้ (This Week) และปฏิทินกิจกรรมสัปดาหหนา (Next 
Week) 

ผูที่ไดรับมอบหมายใหเปนผูดูแลเว็บของหนวยงานตาง ๆ 
ที่แจงช่ือไวกับทางสํานักคอมพิวเตอรในระบบ SWU 
WebHelp จะไดรับสิทธิ์ในการลงประกาศในปฏิทินกิจกรรม
ของมหาวิทยาลัย ขาวที่สงมานั้นจะถูกนําขึ้นเผยแพรในสวน
พื้นที่ “ปฏิทินกิจกรรม” ในโฮมเพจของมหาวิทยาลัยและใน
เว็บไซต “ปฏิทิน มศว”  
� ปฏิทินการศึกษา 
ผูสนใจสามารถเขาดูปฏิทินการศึกษาโดยคลิกเลือกจากเมนู

ดานซายมือในหัวขอ ปฏิทินการศึกษา และสามารถ Download 
เอกสารปฏิทินการศึกษาในรูปแบบ PDF File ทั้งระดับปริญญาตรี
และบัณฑิตศึกษา โดยในหนาแรกของปฏิทินการศึกษาระบบจะ
แสดงรายการตามเดือนปจจุบัน และแยกแสดงของระดับ
ปริญญาตรีและบัณฑิตศึกษา 
เพื่ออํานวยความสะดวกแกผูเขาชม ระบบไดจัดเตรียมกลุม

เมนูเพื่อแสดงปฏิทินกิจกรรมออกเปน กิจกรรมประจําเดือน (This 
Month) และประจําภาคการศึกษา (This Semester) 
� การคนหากําหนดการกิจกรรม 
ผูสนใจสามารถคนหาและดูกําหนดกิจกรรมได 2 วิธี ดังนี้ 
วิธีที่ 1 โดยพิมพ keywords ลงในกลองคนหา แลวคลิก
เลือกวาตองการคนจากปฏิทินการศึกษาหรือ ปฎิทินกิจกรรม 

วิธีที่ 2 โดยคลิกเลือกเดือนและวันที่ตองการจากปฏิทินที่อยู
ทางซายมือ  
ขอเชิญชวนบุคลากรและนิสิต มศว สัมผัสและทดลอง

ใช ปฏิทิน มศว ไดที่ calendar.swu.ac.th  
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อานดีดี   มีรางวัล 
http://cc.swu.ac.th/ 

ขาวกิจกรรมและบริการ 
สํานักคอมพิวเตอร 

ประกันคุณภาพการศึกษา  
ในวันอังคารที่ 24 สิงหาคม 2546  สํานักคอมพิวเตอรไดรับ

การตรวจประกันคุณภาพการศึกษาภายใน ประจําปการศึกษา 
2546 โดยคณะกรรมการประเมินคุณภาพการศึกษาภายใน มี 
ผศ.กิตติมา สังขเกษม เปนประธานกรรมการ    ไดศึกษาและ
ตรวจสอบขอมูล  พรอมทั้งเขาเยี่ยมชมสถานที่ปฏิบัติงานและ
การใหบริการภายในสํานักคอมพิวเตอร  และใหขอเสนอแนะ 
เพื่อใหสํานักคอมพิวเตอรนําไปปรับปรุงตอไป 

 
การเยี่ยมชมและศึกษาดูงาน  
เมื่อวันที่ 20 สิงหาคม 2547 คณะนิสิต ลงทะเบียนเรียนใน 

รายวิ ชา  บส  352 เทคโนโลยี การสื่ อสารข อมู ล   ภาควิ ชา
บรรณารักษและสารสนเทศศาสตร เขามาศึกษาดูงานเกี่ยวกับ
ระบบเครือขายและการบริหารจัดการระบบเครือขายของ มศว 
จํานวน 12 คน 

โครงการอบรมคอมพิวเตอร 
สํานักคอมพิวเตอรไดจัดอบรมโครงการบริการวิชาการดาน

คอมพิวเตอร  ดูรายละเอียดที่ http://cc.swu.ac.th/training/ 
• ครั้งที่ 49 4 สิงหาคม  ถึง 10  กันยายน 2547  

 สําหรับนิสิตทุกระดับ  
• ครั้งที่ 50  13 สิงหาคม  ถึง 17 กันยายน 2547 

 สําหรับบุคลากร 
• โครงการอบรมสําหรับผูดูแลเว็บของมหาวิทยาลัย 

 22 กรกฎาคม  ถึง 8 กันยายน 2547 

โครงการอบรมปฏิบัติการ 
สํานักคอมพิวเตอรจัดโครงกาอบรมปฏิบัติการ เรื่อง การจัด

การเรียนแบบออนไลนดวยระบบ  Open Source LMS “ATutor”  
รุนที่ 3   ระหวางวันที่   10  -  14  กรกฎาคม   2547  มีจํานวน 
ผูเขาอบรมทั้งส้ิน   106  คน    ใน  3   หลักสูตร  ดังนี้ 

หลักสูตร เรื่อง ผูเขาอบรม 
1 การใชระบบ ATutor 40 คน 
2 การติดตั้งและดูแลระบบ  ATutor 32 คน 
3 การปรับแตงระบบ ATutor  34 คน 

ดวย PHP และ MySQL 

 
ภาพพิธีเปดการอบรม ATutor  รุนที่ 3 

สํานักคอมพิวเตอรจะจัดโครงการอบรมปฏิบัติการ เรื่อง การ
จัดการเรียนแบบออนไลนด วยระบบ   Open Source LMS 
“ATutor” รุนพิเศษ  ระหวางวันที่  18 - 19 กันยายน 2547   
สําหรับศึกษานิเทศน ครู หรือ บุคลากรทางการศึกษา 
และรุนที่  4  ระหวางวันที่ 20 - 21 พฤศจิกายน 2547 

 จะเปดอบรม หลักสูตร 1 และหลักสูตร 2 
ดูรายละเอียดที่ http://cc.swu.ac.th/training/ 

บุคลากร 
นางสาวกุลยา  แสงไสว เจาหนาที่บริหารงานทั่วไป 
พนักงานชั่วคราว  ลาออกเมื่อวันที่ 9 สิงหาคม 2547 

นายชัยวัฒน  ชางกลึง  นักวิชาการคอมพิวเตอร  
พนักงานมหาวิทยาลัยใหม บรรจุเมื่อวันที่ 1 กันยายน 2547 

อานดีดี  มีรางวัล 
รายชื่อผูไดรับรางวัลประจําจดหมายขาวปที่ 8 ฉบับที่ 3 
1. นายอุรุพงษ  สรอยสะอาด คณะพลศึกษา 
2. นางสาวสุรียพร หลออุดมทรัพย คณะพลศึกษา 
    มารับรางวัลไดที่สํานักคอมพิวเตอร ชั้น 4 อาคาร 16  

ภายในวันที่ 20 กันยายน 2547  

 


